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8.

Mark only one oval.

Diploma in Pharmacy

Bachelor of Pharmacy

B.TECH.(CSE)

B.TECH.(ECE)

BCA

B.SC.(CS)

B.SC.(BT)

B.SC.(ANCS)

B.SC.(HN)

B.Sc.(MM)

B.A.(MW)

BBA

B.COM

B.A.(JMC)

BBA(HM)

BBA(LLB)

B.OPTOMETRY

B.SC.(MB)

B.SC.(MLT)

B.SC.(MRIT)

B.SC.(PA)

LLB

B.SC(IT)-AI

B.SC.(MSJ)

Bachelor of Physiotherapy

B.SC.(AM)

Dip.CSE

Dip.ECE

DIP.EE

DIP.CE

*

https://www.google.com/url?q=http://B.COM&sa=D&source=editors&ust=1628705424644000&usg=AFQjCNHjN0_s6srAXDvmaQvkJce2Uh2IwA
https://www.google.com/url?q=http://B.SC&sa=D&source=editors&ust=1628705424645000&usg=AFQjCNF_QAeTMlJSjBpiYNjfmSayp6a61g
https://www.google.com/url?q=http://DIP.EE&sa=D&source=editors&ust=1628705424646000&usg=AFQjCNH-ixQkgZX_PyjOHdetNdVsIaJdVA
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DIP.CE
DIP.ME

PGDHM

MBA

M.SC.(BT)

M.TECH(CSE)

LLM

M.A.(JMC)

M.A.(ENG)

M.SC.(MATH)

M.SC.(MB)

MCA

M.SC.(MSJ)

M.SC.(AM)

M.SC.CS)

M.SC.(ANCS)

M.SC.(MM)

B.A.(Eng)

Answer all the questions. Each question carry one mark.

9.

Mark only one oval.

When you bind a model to a skeleton, it is called skinning.

Building the skeletons is skinning

To animate the character

None of these

1. What is skinning?

https://www.google.com/url?q=http://DIP.ME&sa=D&source=editors&ust=1628705424646000&usg=AFQjCNEQTKOFoHfvsAQsvpORPnD24v1rxw
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10.

Mark only one oval.

Select edit > Interactive Bind Skin

Select Skin > Interactive Bind Skin

Select control > Interactive Bind Skin

None of these

11.

Mark only one oval.

Coloring

Sculpting

Air Brushing

Texturing

12.

Mark only one oval.

Reflection

Specularity

Glossiness

Transparency

2. To open and change the Interactive Bind Skin Options ___________________.

3. Once the character or object is built in the program, what is the process called
of adding color, reflection, transparency, translucency and roughness?

4. To create real world reflections in most software packages, the "reflection" is
actually made up of three parts. Can you guess which of the following is not part
of the reflection channel?
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13.

Mark only one oval.

Radiosity

Dynamics

Volumetrics

Hypervoxels

14.

Mark only one oval.

Dynamics

Simulations

Real world events

Motions

15.

Mark only one oval.

Render Farm

Render Heard

Render Command Module

Render Unit

5. Light in the real world continually bounces off of objects to illuminate an area. In
the 3D software, this real world light simulation is extremely render intensive on the
computer, but produces beautiful results. Can you guess what most software dubs
this simulation?

6. Everything in a 3D scene has to be either manually animated or calculated by the
computer, as nothing is preset in the software. What is the calculation called to
recreate real world effects such as gravity, wind, liquids and collisions?

7. A collection of computers linked together to render different frames of a single
animation are referred to as what?
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16.

Mark only one oval.

Mapping

UV coordinates

unwrapping

None of these

17.

Mark only one oval.

UV coordinates

mapping

texture mapping

None of these

18.

Mark only one oval.

UV coordinates

UV unwrapping

texture mapping

None of these

8. A texture is basically a 2D image placed on a 3D model, including some data
called

9. The UV coordinates determine where exactly to apply (or map) the texture on
the model. This mapping process is simply called

10. The action of creating or modifying UV coordinates is called
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19.

Mark only one oval.

Directional Light

Ambient Light

Point Light

Spot Light

20.

Mark only one oval.

Point Light

Ambient Light

Directional Light

Spot Light

21.

Mark only one oval.

Point Light

Ambient Light

Spot Light

Directional Light

11. Which light in Maya is used to simulate the combination of direct and indirect
lighting.

12. Which light is used to simulate sunlight because it uses parallel rays of light as if
illuminating the object from far distance.

13. Which lights in Maya shines evenly in all direction from small point source
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22.

Mark only one oval.

Ambient Light

Spot Light

Point Light

Directional Light

23.

Mark only one oval.

Area light

Point Light

Directional Light

Ambient Light

24.

Mark only one oval.

Reflection

Layered textures

Environment textures

None of these

14. Which light in Maya shines a beam of light in a direction defined by a cone

15. Which light is physical based 2 dimensional rectangular light source

16. Which textures are commonly used either as backgrounds for objects in your
scene or as reflection maps.
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25.

Mark only one oval.

Hollow Dome Range Lights

High Dynamic Range Images

Hyper Dynamic Range Ions

None of these

26.

Mark only one oval.

Incandescent Enhanced Setup

Interior Environment Setup

Illuminating Engineering Society

None of these

27.

Mark only one oval.

Calculating the direct and indirect lights.

Creating a matte white texture

Reflecting the direct light

Create smooth shadows.

17. What is the full form of HDRI?

18. What is the full form of IES lights?

19. What is the significance of Ambient Occlusion material?
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28.

Mark only one oval.

One

Two

Three

Four

29.

Mark only one oval.

Each pixel of the HDRI image simulate light.

The Sun in the image emit light

Additional light is created to emit light

All of these

30.

Mark only one oval.

Area Light

Directional Light

Point Light

None of these

20. How many shapes of aiArea Light can we find in Maya?

21. In aiSkydome light

22. The light which emits photons in all direction is called:
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31.

Mark only one oval.

Stencil map

Bump map

Spot light

Transform

32.

Mark only one oval.

Reflection

Refraction

Bump

Roughness

33.

Mark only one oval.

Refraction

Reflection

Bump

Roughness

23. Combining Color map and transparency map creates:

24. For which properties of the material we can distinguish between liquid and
glass?

25. For which properties of a material we can distinguish between wood and
metal?
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34.

Mark only one oval.

Calculating the direct and indirect light

Calculating the color temperature

Calculating the color

All of these

35.

Mark only one oval.

Direction light

Physical sky

Area Light

Point Light

36.

Mark only one oval.

Export

Batch Rendering

Save As

Make Movie

26. Ray tracing in 3d signifies:

27. A light which is used to simulate the sun light and works by rotation is called:

28. The name of the process that you can use to create a sequence of images for
your scene inside Maya is?
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37.

Mark only one oval.

Hypershade

Node Editor

Graph Editor

Light Editor

38.

Mark only one oval.

Bend

Sine

Wave

Lens flare

39.

Mark only one oval.

Area Light

Spot light

Directional Light

Point Light

29. Which Editor Is Used To Create, Edit, And Connect Rendering Nodes, Such As
Textures, Materials, Lights, Rendering Utilities, And Special Effects?

30. In Maya , one of the following is not a non-linear deformer

31. Which light has been used for rendering the given image?
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40.

Mark only one oval.

Spot Light

Light cool

Light fog

Lens flare

41.

Mark only one oval.

Ambient Light

Direction light

Spot Light

Point Light

42.

Mark only one oval.

Ctrl

Insert

Home

Shift

32. Which among the following materials is a volumtric material?

33. Which light is uded to simulate a combination of direct light and indirect light?

34. Which keyboard shortcut lets toy editi the particle object in edit mode?
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43.

Mark only one oval.

Graph

Ramp

Spot Img

All of these

44.

Mark only one oval.

Phong

Anisotropic

Blinn

Lambert

45.

Mark only one oval.

Ambient Light

Spot light

Direction light

Point light

35. Which is a 3D texture type?

36. Which meterial type is used for representing matte surfaces with no specular
highlights, such as chalk or unpolished surfaces?

37. Which type of light maya automatically creatye during render, if there is no light
in the scene?
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46.

Mark only one oval.

Max

JPEG

PNG

Maya IFF

47.

Mark only one oval.

Only Autodesk-approved software.

Any scanning software capable of digitally scanning paintings

Any text editing or word processing software

All of these

48.

Mark only one oval.

Increase the gamma of the reflected image

Project images into the lava lamp

Get more detail in the reflective metal of the base and cap

Mirror the image of the lava lamp

38. Which output image file formats can store the depth channels in one file

39. What software can you use to edit textures externally to Maya?

40. A reflection card is used to
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49.

Mark only one oval.

A scan of an eye

A pupil texture

A black circle

A ramp

50.

Mark only one oval.

More complex and physically accurate shaders

Types of toon shaders

Usually just greyscale shaders

Low complexity shaders

51.

Mark only one oval.

serpentine

felsic

mafic

shale

41. What was used to create the pupil for the eye texture?

42. MISSS shaders are ... ?

43. The light-colored igneous rocks are called
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52.

Mark only one oval.

Lens flare

Area Light

Ambient Light

Point Light

53.

Mark only one oval.

creates a joint system based on the topology of the surface

allows you use several target shapes to help reshape another piece of geometry.

is a special object you use to control the deformation effects of rigid skinning.

ets you manually sculpt NURBS, polygons, or Subdivision surfaces quickly with the
stroke of a brush

54.

Mark only one oval.

Flexors.

Add Influence

Projection Box.

Both Add Influence and Flexors.

44. Which Of These Is A Software Renderer Type For Particles??

45. Which of the following BEST describes the Blend Shape deformer?

46. Which of the following is a way to control deformations using a Smooth Bind?
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55.

Mark only one oval.

Has a default value of 0.5.

Controls the spread of the specular highlight

Controls the color of shiny highlights on the surface

Both Has a default value of 0.5. and Controls the color of shiny highlights on the
surface

56.

Mark only one oval.

Spot Lights.

Directional Lights.

Area Lights.

All Maya Lights

57.

Mark only one oval.

Add vertices to a selected dynamic constraint

Remove vertices from a selected dynamic constraint

Both of these

Neither Add vertices to a selected dynamic constraint and Remove vertices from a
selected dynamic constraint

47. Which of the following is true of the Specular Color Attribute in a Blinn Shader?

48. Which light(s) can be positioned using Look Through Selected Camera?

49. What does the nConstraint Membership Tool for nCloth allows users to do?
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58.

Mark only one oval.

OBJ

FBX

DXF

None of these

59.

Mark only one oval.

Go to Ramp and click create

In Menu bar, go to create option and select Lights and click on a light you need in the
scene

Click the Lambert

None of these

60.

Mark only one oval.

Surface model

Wire frame model

Solid model

Isometric model

50. Which file format lets you exchange complex data between Maya and other
software while preserving the data's overall behavior?

51. Where will you get these lights?

52. The model which is created by using basic entities of two dimensioning is
called __________
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61.

Mark only one oval.

Graphics uniform interaction

Graphical user interaction

Graphical user interface

None of these

62.

Mark only one oval.

Reflection

Translation

Shearing

Transformation

63.

Mark only one oval.

Union

Divide

Difference

Intersection

53. GUI stands for -

54. The process of positioning an object along a straight line path from one
coordinate point to another is called -

55. One of the following is not a Boolean operation type:
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64.

Mark only one oval.

Color > UV texture editor

Create UVs > UV texture editor

Edit UVs > UV texture editor

Assets>UV texture editor

65.

Mark only one oval.

Modeling

Animation / Rigging

Texturing

Rendering

66.

Mark only one oval.

Modeling

Animation / Rigging

Dynamics

Rendering

56. We can find “UV texture editor” in Maya under

57. In Maya UV's related with which following process?

58. The term Lofting in Maya is related with _______
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67.

Mark only one oval.

Texturing

Dynamics

Animation / Rigging

Rendering

68.

Mark only one oval.

Modeling

Animation / Rigging

Dynamics

Rendering

69.

Mark only one oval.

Graph Editor

Fields

Move Tool

UV Texture Editor

59. Match the term Clusters in Maya with ______

60. In Maya Hypershade can be used in which of the following process?

61. Tangent can be matched with __________
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70.

Mark only one oval.

Select object > Edit Mesh > Smooth

Select object > Mesh > Smooth

Surface > Smooth

Modify > Smooth

71.

Mark only one oval.

Maya Hardware Render

Maya Vector Render

Maya Mental Ray Render

None of these

72.

Mark only one oval.

Light Fog

Cast fog

Reflection

None of these

62. To apply the Smooth in polygon object in Maya we need to perform which of
the following method

63. Render Caustics effects with photon tracing using by

64. Which Among These Fog Types Can Cast Shadows?
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73.

Mark only one oval.

Edit Mode

OBJ Mode

LifespanMode

All of these

74.

Mark only one oval.

Press S

Press D or Insert.

Press T

Press R

75.

Mark only one oval.

UV Fog

Light cool

Volume Fog

Volume Light

65. Which Attribute For A Particle Per Object Is Set To “live Forever” In Order To
Make The Particles Live For Ever?

66. Which Key Would You Press In Order To Turn On The Pivot Point Manipulator?

67. Which Among The Following Materials Is A Volumetric Material?
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76.

Mark only one oval.

Bump map

reflection map

UV map

All of these

77.

Mark only one oval.

Reflection map

Light Effects

Anisotropy

None of these

78.

Mark only one oval.

Anisotropy

Caustics

Low light

None of these

This content is neither created nor endorsed by Google.

68. Whach map is an image of what you want reflected?

69. Whach map is used when you have bumps and gouges that happen across a
shiny surface in a parallel way

70. Which map is used when you have light either reflecting or refracting from a
curved surface
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